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Management Central uses the basic system operations on each of the endpoints (e.g., APIs for performance monitoring, system commands, etc.).  Management 
Central does not place any limitation on the number of endpoint systems used by its functions. There will be practical limits determined by your environment, 
networks, management policies, etc..   In addition, there  is no limit to the number of endpoint systems that can be in a group

Endpoints do not need to be at the same level as the Central System, nor does the Central System need to be at the same level as the Client, HOWEVER, 
Management Central is only as good as the client and Central System combination

PC provides the graphical interface (i.e., view) both input and output of management activities 
General (directs activity)
See results

PC  (usually) only needs to connect to the central system
requires the user id on Central System and Endpoint systems to be the same

Central System connects to other systems (called endpoints).
Takes orders and directs all systems (called endpoints) on what do to (e.g., coordinates all activity)
place where information on activities is stored

Endpoints are just systems which your PC does not need to be in direct contact with in order to "manage"
If you are using LPAR (logical partitions), Management Central will identify and treat each partition as its own endpoint system.
Can be grouped together in System Groups in order to group operations

So how should I determine what my Central System should be?  It's up to each administrator. Administrators may want to coordinate and decide if they will all 
use the same central system (depending on management policy, collaboration, and sharing). Typically they might choose one of the faster, larger systems in the 
network..

Starting in V4R5, administrators have even more flexibility in how they access and interact with their iSeries using Management Central - Pervasive. New capabilities 
have been added in V5R1 so the suite of Pervasive functions now include System Availability, Monitors (system, job and message) and Commands using an Internet 
phone, a personal data assistant (PDA) with a wireless modem, or a traditional web browser on a workstation. 

For our examples, the web application server (i.e. WebSphere) is being used as servlet engine.

Notes: Basics of Management Central
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Release to Release Capability
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Release to Release Capability

Required PTFs for OS/400
5769-SS1 SF62901- Management Central C++ Extensions
5769-SS1 SF64097 - Management Central Application Servlets

Devices
PDA
Web Browers
Internet Phones

Functions
System availability
Monitors

System
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Release to Release Capability

Required PTFs for OS/400
5722-SS1 TBD - Management Central Application Servlets

Devices
PDA
Web Browers
Internet Phones

Functions
System availability
Monitors

System

Language support
Set the Language_Country and characterset for a PC Browser
http://sysname:port/servlet/McYpvPerv?LNG=lang

where 'sysname' is your central system name
where 'port' is the port your servlet is configured
where 'lang' is the language (Lang_Country)
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In V5R1, the servlet McYpvPerv provides NLS enablement support for the Pervasive function delivered in V4R5.

The Supported Languages with their browser settings for Language_Country and characterset are:

Language             Lang_Country Characterset Language             Lang_Country Characterset
Chinese Simplified zh        gb2312 Hungarian            hu        iso-8859-2
Chinese Traditional zh_TW big5 Italian                 i t         iso-8859-1
Croatian                hr        iso-8859-2 Italian Swiss     it_CH     iso-8859-1
Czech                   cs        iso-8859-2 Japanese                 ja        shift-jis
Dutch                   nl        iso-8859-1 Korean     k o         euc-kr
Dutch Belgian nl_BE     iso-8859-1 Polish        pl        iso-8859-2
English                 en        iso-8859-1 Portuguese        pt        iso-8859-1
French                  fr        iso-8859-1 Portuguese Brazilian pt_BR     iso-8859-1
French Belgium    fr_BE     iso-8859-1 Romanian             ro        iso-8859-2
French Canadian     fr_CA     iso-8859-1 Russian              ru        indows-1251
French Swiss    fr_CH    iso-8859-1 Slovakian             sk       iso-8859-2
German     de       iso-8859-1 Slovenian           sl        iso-8859-2
German Swiss de_CH     iso-8859-1 Spanish                es        iso-8859-1
Greek                   el        iso-8859-7

To set the Language_Country and characterset for a PC Browser

Netscape:
To set Language from tool bar select Edit-> Preferences -> click on Languages (click on add button to see list of  browser possibilities)  First one in list will be the one 
used.  
To set  Characterset from tool bar select: View -> Characterset

Explorer:
To set Language from tool bar select Tools -> Internet Options -> click on Languages button  (click on add button to see list of  browser possibilities)  First one in list will 
be the one used.    

To set  Characterset from tool bar select: View -> Encoding  (may have to select more to see entire list)

To force language setting via URL
Add language parameter ?lng= after url      (i.e. ?lng=zz )   where zz is  Language_Country to be used. 

Notes: V5R1 NLS Enabled
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Release to Release Capability

Required PTFs for OS/400
5722-SS1 TBD - Management Central Application Servlets

Devices
PDA
Web Browers
Internet Phones

Functions
System availability
Monitors

System
Job (new)
Message (new)

Commands (new)
Work with monitored jobs and messages (new)
Integrated xSeries/Netfinity Server Status (new)
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Installation and Configuration
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Installation and Configuration

Endpoint System
V4R3 or higher OS/400 release

Central System
iSeries must be at one of the following:

V4R5 + PTFs
V5R1+ PTFs

Firewall
Protection plan implementation (security)
Update or create configuration based on software used
Redbook: SG24-5954-00 AS/400 Internet Security Scenarios: A Practical Approach

Web Application Server
Give proper authority to user
Update classpath information

HTTP Server
Protection plan implementation  (security)
Add MIME Type (phone only)
Request Routing (phone only)

AS/400 Systems
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Notes: AS/400 Systems Installation and Configuration

Endpoint System Software Requirements
The endpoint systems when not playing the role of the central system are only required to have OS/400 V4R3 release or higher install with 
Management Central started.  This assumes a TCP/IP network.

Central System Software Requirements
To start you need to install either:

V5R1 OS/400 with Management Central - Pervasive add function PTFs  (TBD - prior to GA) -or-
V4R5 OS/400 with Management Central - Pervasive add function PTFs  SF62901 and SF64097 for 5769-SS1.  PTF SF62901 provides the 

code which enables the existing Management Central performance monitors to interact with other application servlets.  PTF SF64097 is 
the application servlet which will feed the information back to the device of your choice (phone, PDA, or browser) Note:  After installing 
the PTFs, you will need to move the MC - Pervasive Java programs to the appropriate location.  Typically this would be done by using 
the command, RST DEV('/QSYS.LIB/QYPVPERVSF.FILE') OBJ(('/QIBM/PRODDATA/OS400/*')).  However, the OBJ value shown 
can be changed depending on your web application server setup.

Firewall
When you use Management Central - Pervasive, you will be accessing at least one of your systems from the Internet.  If you access any of your 
systems from the Internet today, you probably have a firewall set up to prevent unauthorized access. Depending on your firewall configuration, 
you may have to modify your firewall setup to run MC - Pervasive.  If you have never accessed your systems from the Internet and do not have a 
firewall setup, the following IBM Redbook provides strategies for doing so in Chapters 8 and 9.  See AS/400 Internet Security Scenarios: A 
Practical Approach, SG24-5954-00.  IBM Redbooks can be found online at www.redbooks.ibm.com.

Central System Web Application Server
To access the new MC-Pervasive servlet, you must have installed and configured a web application server.  Our team in Rochester has 
successfully utilized:

WebSphere Application Server 3.02 Standard Edition
WebSphere Application Server 3.5 Standard and Advanced Edition
Domino Application Server

However, any web application server which has the capability to host servlets for serving Internet information should work. Remember:  You 

must have created at least one server instance to run the servlet.
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When using Domino the id will be QNOTES

Web Application Server (WebSphere Example)

Give proper authority to user 
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Give Proper Authority to Users
User profile that will run the McYpvPervasive servlet:

*USE authority to QSYS/QYPVJNI *SRVPGM.  (i.e. QEJBSVR)
Read authority to the directory 

V4R5: /QIBM/ProdData/OS400
V5R1: /QIBM/ProdData/OS400/MGTC/Pervasive

Read/write authority to the directory 
V4R5: /QIBM/UserData/OS400
V5R1; /QIBM/UserData/OS400/MGTC/Pervasive

Any users of MC-Pervasive will also require:
Read/write authority to the directory 

V5R1 only; /QIBM/UserData/OS400/MGTC/Pervasive

The servlet will create and update text files in the UserData directory with the name  QYPVxxxxxx.txt where xxxxx is the AS/400 user 
id.  Each text file has the list of endpoint systems separated by commas that a user is interested in monitoring. A default list can be 
created with the name 'qypv_systems.txt'. 

Notes: AS/400 Systems Installation and Configuration
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Web Application Server
Update classpath information

1 2

3

4 5
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You must add the two jar files used by the MC - Pervasive servlet to the web application server.  For example, when using WebSphere, 

1. Open the WebSphere Administrative Console
2. Select the Topology tab
3. Select the application server that will be running the MC - Pervasive servlet

4. Add the following classpath information to the command line arguments parameter:
(V4R5) -classpath 

/QIBM/ProdData/OS400:
/QIBM/ProdData/OS400/mcypvperv.jar:

/QIBM/ProdData/Http/Public/jt400/lib/jt400.jar 

(V5R1) -classpath 
/QIBM/ProdData/OS400/MGTC/Pervasive:
/QIBM/ProdData/OS400/MGTC/Pervasive/mcypvperv.jar:
/QIBM/ProdData/OS400/MGTC/McClient.jar:
/QIBM/ProdData/OS400/MGTC/McOSClient.jar:
/QIBM/ProdData/OS400/MGTC/McPrivServer.jar:
/QIBM/ProdData/OS400/MGTC/mcyrmcom.jar:
/QIBM/ProdData/OS400/jt400/lib/jt400Native.jar:

5. Then press apply

Note:  After to change the classpath, you must stop and start the server instance for the change to take effect.

Notes: Update classpath Information
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HTTP Server
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HTTP Server
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HTTP Server
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iSeriesIBM serverAdd MIME Type (phone only)

HTTP Server
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HTTP Server
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Notes: AS/400 Systems Installation and Configuration

The web application server will have to be configured or setup to provide the necessary level of security. Set up the web application server to 
implement the protection plan developed to provide proper authentication security based upon your client devices, browsers and network. IBM 
recommends implementing HTTP with SSL (HTTPs) whenever possible.

In order for the servlet to be able to send back the bitmap, the HTTP server must know where it is located, and it must know how to 
handle bitmap files. In order to access the HTTP configuration, go to the 2001 port on the system running HTTP. Under the HTTP 
configuration you will need:

Request processing -> Request routing
Action:  Pass
V4R5

URL Template:  /McYpvPervasive/*
Replacement file path:  /QIBM/ProdData/OS400/*

V5R1-NLS
URL Template:  /McYpvPerv/*
Replacement file path:  /QIBM/ProdData/OS400/MGTC/Pervasive/*

V5R1
URL Template:  /McYpvPervasive/*

Replacement file path:  /QIBM/ProdData/OS400/MGTC/Pervasive/*

Languages and Encoding -> MIME Types
File extension:    .bmp
Content type:      image/bmp
Encoding:           binary
Quality:               1.0
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Installation and Configuration
PC Workstation

Requires
V4R4 or V4R5 or V5R1 Client Access Express for Windows (57xx-XE1)
Microsoft Windows - 95, 98, NT 4.0 or 2000 Professional
TCP/IP Network

Install
Setup TCP/IP on both the PC and AS/400
Setup Client for Microsoft Networks
Find CA/400 folder on AS/400 using AS/400 NetServer
Install CA/400 (see following pages)
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Installation and Configuration
Install CA/400
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Installation and Configuration
Install CA/400 cont...
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Notes: PC WS Installation and Configuration

Operations Navigator components used by MC-Pervasive are NOT installed with a typical installation of  Client Access Express (V4R4 
or later). When installing (Client Access or Client Access Express), choose 'Custom Install'. Expand the Operations Navigator tree then 
select the appropriate components:

V4R5 - Select Management Central
V5R1 - Select Monitors and Commands (you may select more but you will need at least these 2 components) 

Deselecting Operations Navigator and reselecting will result in all components to be selected so you get ALL the functions..

From this workstation, the user is able to set up the monitors, which will be viewed using the new devices. 
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Pervasive Devices
Phone

Primary Elements
Physical Characteristics
Web Browser

Wireless Internet Services

Compatibility Considerations
Mitsubishi T250

Tested through device
AT&T PocketNet wireless service
Recommended the small font preference

Ericsson R280 LX
Tested using simulator

Other UP.Browser® enabled devices
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Notes: Phone Pervasive Devices

Primary elements
Physical Characteristics
The display size of the phone often affects how easy it is to use.  In general, the more horizontal lines the phone displays, the easier it is to view 
data.  Regardless of the display size, you will often need to scroll down in the phone display using buttons or other scrolling mechanism.  The 
width of the displayed lines should also be a consideration.  A good line width will minimize text wrapping or horizontal scrolling.

Note:  When setting up the endpoint systems, they will be truncated in the phone display to 10 characters.

Web Browser
An Internet phone is typically already loaded with a microbrowser. Once you select a particular phone, you are also making your browser choice. 
MC - Pervasive currently supports the UP.Browser® microbrowser. For best results, choose a phone that supports this microbrowser. 

Wireless Internet Services
The wireless Internet service is what transports the data to and from your phone.  It is not the same as the voice service for your phone; although 
the two may be packaged together by a particular provider. Make sure the phone you select is supported by a wireless Internet service available 
in the geographical areas where you want to use it.  During our testing, we used AT&T Wireless Services.  

Note:  The amount of data in which the phone is limited to 1460 unlike the PDA.  This will be noticed by the phone user by the extensive 
accesses to the network.

Compatibility considerations
The Mitsubishi T250 and  Ericsson R280 LX were tested and are known to be compatible with Management Central - Pervasive.  As 
stated earlier, MC - Pervasive supports the UP.Browser® microbrowser. The UP.Browser® is licensed by over 20 phone manufacturers 
around the world. In addition, many of the manufacturers offer the UP.Browser® on more than one model of phone. The list of phones 
supported by the UP.Browser® can be found at the Phone.com website (www.phone.com).
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Pervasive Devices
PDA

Primary Elements
Web Browser
Wireless Internet Services

Compatibility Considerations
Palm OS Version 3.3
AT&T Wireless
Browsers

AvantGo Version 3
EudoraWeb Version 1.1

Hardware devices
PalmIII with Minstrel III modem
PalmIIIx with Minstrel III modem
PalmV with Minstrel V modem
PalmVx with Minstrel V modem
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Notes: PDA Pervasive Devices

Primary elements
Browser
Management Central-Pervasive leverages a web browser running on your PDA which are typically free for download.  There are many different 
web browsers that exist for PDA devices. Often, the browsers differ in what HTML elements they support. Some browsers handle text differently. 
Some display images and tables, while others do not. Some browsers offer higher levels of protection or security. The following browsers support 
the necessary elements to run MC - Pervasive from a PDA: 

AvantGo Version 3 (www.avantgo.com)                               Supports SSL
EudoraWeb version 1.1 (www.eudora.com) Does not support SSL

Modem and Wireless Internet Service
You need to choose a modem which is compatible with your PDA selection. In addition, you need to find a wireless Internet service provider. The 
wireless Internet service transports the data to and from your PDA using the modem. When choosing a modem and service, make sure that you 
select a combination that is supported in the geographical areas where you want to use your PDA During our testing, we used AT&T Wireless 
Services.  

Compatibility considerations
Many PDAs are  likely to be compatible. Since MC - Pervasive runs in a browser, the choice of PDA shouldn't make a difference, but 
only the PDAs listed were tested. Also, any device that allows you to perform live web browsing and supports HTML may be compatible 
with MC - Pervasive.  The following PDAs were tested and are compatible

PDA Operating System Wireless Modem Wireless Service
Palm V or Vx Palm OS Version 3.3 Minstrel V AT&T
Palm III or IIIx Palm OS Version 3.3 Minstrel III AT&T
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Pervasive Devices
Web Browser

Primary Elements
Web Browser
Easiest option for intranets!

Compatibility Considerations
Any web browser should work!
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Notes: Web Browser Pervasive Devices

Management Central - Pervasive is designed to run on an Internet phone or PDA. However, because it runs on a browser in a PDA, MC 
- Pervasive will also run on a traditional web browser. Any current workstation web browser should work because PDA browsers have 
more limitations.  

You might consider placing your browser in the corner of your workstation to keep current on your systems and monitors without 
having to clutter up your whole desktop.
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How It Works!

Setting up a monitor
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How It Works!
Setting up a monitor

1. Connect the PC workstation to V5R1 Central System
2. Add endpoint systems
3. Create your monitor
4. Start your monitor
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Setting up a monitor
Step 1:  Connect the PC workstation to V5R1 Central System
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To get to Management Central functions, you will need to locate and open the AS/400 Operations Navigator icon.  It could be on your desktop or 
in the start menu->Programs->IBM AS400 Client Access Express folder.  If you have installed the the components correctly, you will see it shown 
at the top of the left pane.  You will see a default central system when you first open the window.  If this is not the system inwhich the web 
application server and HTTP are installed and configured, you will need to change the Central System.  To change the central system, select then 
right click on the Management Central item.  Click on the Properties menu item to change any of the Management Central configuration 

including the central system.

Notes: Connect the PC workstation Central System
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Setting up a monitor
Step 2:  Add endpoint systems
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Notes: Add Endpoint Systems

Only systems defined as endpoint systems in Management Central will show up in MC - Pervasive, therefore you'll want to define (add)  
the systems in your network to the list in Management Central so that you can monitor status.  In Operations Navigator, explore 
Management Central, right-click on AS/400 Endpoint Systems, and select New Endpoint System.  

The New Endpoint System - General page allows you to define a new endpoint system by specifying the name and description of the 
system.  An endpoint system is defined by any user on the central system for the purpose of performing distributed functions.  An 
endpoint system must be connected to the Central System and must be running OS/400. The level of OS/400 that is running on the 
endpoint system determines which functions are available on that system (see below).  The endpoint system cannot be running a release 
of OS/400 earlier than V3R1.  The only time AS/400 connections are added automatically is when you connect to the central system for 
the very first time (after install).  Otherwise, you will need to create each endpoint system entry individually or perform a discovery.  

When creating endpoint systems  individually, the name you specify for the new endpoint system, must be known to TCP/IP, either as 
an entry in your AS/400 local host table or on your domain name server (DNS). 

When using the Discover Systems dialog to search the selected TCP/IP subnets for AS/400 systems, the AS/400 systems found are added 
as endpoint systems on the Central System.  If the AS/400 system is already defined as an endpoint system, the IP address is verified 
and updated if it has changed.  This search can be done every time the Management Central server starts or as needed by user requests. 

Management Central Functions - The level of OS/400 that is running on the endpoint system determines which Management Central 
functions are available on that system.  The endpoint system cannot be running a release of OS/400 earlier than V3R1. The following 
shows which Management Central functions are available at each release.

V5R1: Historical Graphs, Product/PTF Packaging, Job Monitors, Message Monitors, System Value Management and User 
Administration, Addition Inventories
V4R4: Monitors, Event Log, Fixes (PTF) Management, Collection Services, Remote Commands, Package Distribution,  Inventory
V4R3: Monitors, Event Log
V3R1 -- V4R2: Monitors (must be running the IBM Performance Investigator for OS/400 PRPQ)
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© Copyright 2001 IBM Corporation.  All rights reserved. May 2001 Pages 37-38



IBM Confidential Until Announced 8 2001 IBM Corporation

iSeriesIBM server

System1
(System1)

System1

Setting up a monitor
Step 3:  Create Your Monitor
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 Notes: Create Your Monitor

Monitors in Management Central can be very powerful. You have the flexibility to have simple or complex monitors, set up thresholds, and 
perform automation if those thresholds occur. The goal of MC - Pervasive is to keep you informed of the status of these monitors wherever you 
are. Create monitors with meaningful names so you will know what it is monitoring just by looking at the monitor name.  Of course, if you need 
detailed information, you can drill down to view the metrics and the values on a specific system.

Note:  Try to keep the monitor names short or they may be truncated or require you to scroll.

This example shows the creation of a single system monitor.  However, MC-Pervasive can display all types of monitors in V5R1 including System, 
Job and Message monitors.  

This example also shows starting the monitor using the Operations Navigator interface.  In V5R1, you can now start your monitors using 
MC-Pervasive.

iSeries Operations Navigator:  Wireless Access ibm.com/eServer/iSeries/Oper_Nav
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(System1)

System1

Setting up a monitor
Step 4:  Start Your Monitor
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The Start Monitor dialog allows you to select the endpoint systems and system groups on which you want to start the monitor.  

To add a system or group to the Selected systems and groups list, select it in the Available systems and groups list, and then click Add.  

To remove a system or group from the Selected systems and groups list, select it in the list, and then click Remove. 

Available systems and groups - A list of endpoint systems and system groups from which you can select a system or group.  Click the plus 
sign (+) next to any group to see the systems that are included in the group.

PC is not required to be connected once monitor is started.

Notes: Start Your Monitor
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How It Works!
Setting up the user's system list

QYPV_SYSTEMS.TXT

Mahlik,System2,System3

MC-Pervasive Servlet

Network &
Web Application Server
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Notes: Setting up the user's system list

Central System URL
Enter the URL of your central system to your wireless device. Use the following format, and make sure that the end of the URL 
(/servlet/McYpvPervasive) is entered exactly as shown:

host.domain:port/servlet/McYpvPervasive 

host: The host name of the central system
domain: The domain the central system is located
port: The port that the MC - Pervasive servlet is listening to

User's System List
When the user connects to the central system via the web applications server, the MC - Pervasive servlet will attempt to locate a user specific or 
custom list of endpoint systems.  If the file does not exist, it will look for the default system list.  At the point which neither is found, a custom 
system list will be created for the user to update using phone, PDA or browser.

The users system list files are put in the path /QIBM/UserData/OS400.  The default file will be named 'QYPV_SYSTEMS.txt'.  The user specific 
or custom files will be named QYPVxxxxx.txt where xxxxx is the user profile.

Note: The default name was selected to contain an underscore to ensure it would not conflict with a user id.
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Setting up the user's System List
Adding endpoint system

Select to add system

Field for system name
(keep it short)

Use button to change from alpha/SYM/NUM 
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Setting up the user's System List
Removing endpoint system

Select to remove system

Select system to remove
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How It Works
Device layouts

Phone
Interface: Card Layout
First view: Summary of systems, monitors and commands
Status indicators: OK, Attention,  ! and bell

PDA Browser
Interface: Card Layout (NEW for V5R1!)
First view: Summary of systems, monitors and commands

number of systems that are unavailable
number of monitors which are triggered or failed
number of command tasks which occurred in last 24 hours

Status indicators: OK, Attention,  ! and *
 Traditional Browser

Same as PDA Browser with larger viewing capacity
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Phone Layout
The first thing you see when using an Internet phone is the summary. It will show you how current the information is, how many 
systems, monitors and commands are in your list, and if any need attention or not. It does this clearly by showing an overall status of OK 
or Attention at the top.  If OK is shown, that means all systems, monitors and commands in your list are running smoothly. If Attention is 
shown, then it means a system, monitor or commands needs more attention. If a system is unavailable, a monitor has failed or a 
command has failed, an exclamation point will be shown next to the link with the item that needs attention. If a monitor has triggered, a 
bell will be shown next to the Monitors link.

PDA Browser Layout
The PDA browser layout is very similar to the Internet phone. The new design has moved it to operate more like the card layout of phone 
to handle the additional monitors and command functions.  However, since the interface has more viewing area addition information 
such as failed, triggered and completed is shown.  Some of the compatible browsers do not support images so an asterisk (*) is used 
instead of the bell to show the triggered status.

Traditional Browser Layout
The traditional browser on a workstation layout is exactly the same as the PDA browser layout. However, because of the increased 
display size, you have the option of seeing all information at once by making the browser window large, or you can choose to put a small 
browser window in the corner of your PC to take advantage of the function while working on other applications.

Notes: Device layouts
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Device layouts (V4R5 example)

Immediate indicator of a problem using the 
bell

Monitors appear to need attention.
Select 'Monitors' to drill down and see the monitor list

CPU Monitor appears to need attention.
Select 'CPU Monitor' to drill down and see the system list

Arrow indicates the item selected for drill down

System1 is where the threshold occurred.
Select 'System1' to see the specific metric information such as CPU avg

*
*
*
*
*

V5R1 - Type of monitor 
selection

*
*
*
*
*

V5R1 - Top 20 jobs 
list

V5R1 - Job 
Properties
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Device layouts (V5R1 example)

Showing Command task status for all my tasks completed within 24 hours

Showing systems and status of tasks on system
The "+" sign shows that the task completed. (smiley face on 
phones)

iSeries Operations Navigator:  Wireless Access ibm.com/eServer/iSeries/Oper_Nav

© Copyright 2001 IBM Corporation.  All rights reserved. May 2001 Pages 49-50



IBM Confidential Until Announced 8 2001 IBM Corporation

iSeriesIBM server

Device layouts (V5R1 example)

Showing Integrated Netfinity/xSeries Server Status (5 servers, 1 started, 4 shut down)

Actions available for all 
servers.
Select an action to run on all servers

Select a server to see 
Properties.
Select an action to run on this server
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FAQ

Frequently Asked Questions
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FAQ

Q: Why don't I see any of my monitors in MC - Pervasive?
A. You will only see the monitors which are running or have failed.  Therefore, if you create a monitor without starting it, it will not be 
in your list.
A. Are you using the same user profile from MC-Pervasive as you did when you created and started the monitor.
A.  (V4R5) If your HTTP server was configured to be case sensitive, try entering your user profile as all CAPS.

Q: Can I add monitors to my list using MC - Pervasive?
A: (V4R5)Only active monitors are displayed. Make sure you start any monitor you want displayed on your wireless device. Currently, 
the only way to start monitors is from the Management Central GUI in Operations Navigator.
A. (V5R1)  You can use the new menu option to started a monitor which is currently stopped.  This will add the monitor to your list.

Q: Can I add systems to my list using MC - Pervasive?
A: Yes. Each user has a customized list of systems that MC - Pervasive will monitor. 
A: (V4R5) On the phone, go to the system list, select Menu, then Add system. On a PDA or web browser, select the Settings button, then 
add systems as needed.
A. (V5R1) Go to the system list. and choose the add system menu item.

Q: What releases does MC - Pervasive support?
A: Your central system must be at V4R5 or later. Your endpoints can be running any release where Management Central runs.

Q: Is it really true that I only need to install MC - Pervasive on one of my systems?
A: Yes, MC - Pervasive only needs to be installed on systems that will be used as the central system for Management Central. Endpoint 
systems will be monitored through that central system, so they do not require any additional installation. Minimally, this means that you 
may only need to install on one system.
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FAQ (continued)

Q: I have recently used MC - Pervasive successfully, but now it is not responding.  What is the problem?
A: More than likely the problem is either caused by a weak signal or a low battery. A weak signal can be caused by the location you 
are using your device. There are parts of some buildings where signals do not reach very well. There are geographic locations where 
wireless service is not available. Low battery conditions seem to occur most often in the wireless modems for PDAs. A low battery in 
the PDA itself or in your Internet phone may also be causing this problem.

Q: Things aren't working and I'm not sure if its related to my wireless device or to my web server setup. What can I do to 
determine where the problem actually is?
A: Try accessing MC - Pervasive through a web browser running on a PC or other workstation. Use the exact same URL that you 
are using from your device. If MC - Pervasive does not work from the workstation web browser, then your problem has nothing to 
do with your wireless device. Make sure that your web application server is up and running. Also, check that you've performed all 
of the configuration steps detailed in the MC - Pervasive Users Guide and make sure that the URL you are using is correct.  If MC - 
Pervasive works from your workstation web browser, then the problem is related to your wireless device. Check if you can access 
any other Internet sites. If you cannot, there is problem with your wireless device or service. If you have never successfully accessed 
an Internet site from your wireless device, contact your wireless service provider. If you have connected to the Internet before, the 
problem could be related to a low battery, a weak signal or a temporary wireless service outage.

Q: Why do I get an Error 500 when I try and run the servlet under WebSphere?
A: This results from WebSphere not being able to find the McYpvPervasive.class servlet. Remember when you enter the URL, it is 
case sensitive. If the servlet name was specified correctly, then the WebSphere web application server classpath does not have the 
correct path specified where this servlet is located.

Q: My brand of phone is not listed in your Users Guide. Will it work?
A: If you already have an Internet phone, just give it a try and see if it works with MC - Pervasive. If it works, let us know and we 
will add it to the users guide. If it doesn't work or doesn't work perfectly, also let us know. Compatibility on a wide range of devices 
is our goal.
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FAQ (continued)

Q: I don't have a wireless modem, but my PDA says it has wireless connectivity built-in. Do I need a separate modem?
A: Some PDAs have built-in modems instead of a separate device that snaps on the back. The term "modem" might not be used 
when they describe their product, but that's effectively what is built-in. A built-in modem meets the need for a wireless modem.

Q: Can I use a wired modem with my PDA instead of a wireless modem?
A: Yes, a wired modem can be used. You need to use the modem to dial an Internet service provider or dial into your corporate 
intranet. The ability to dial into an intranet is an advantage that a wired modem has over a wireless one.

Q: Do the systems in the list of connections and systems used by monitors have to be the same?
A: No.

Q:  I keep getting the error that MC is not available.  What could the problem be?
A:  This typically occurs when the Management Central  Server is not running on the AS/400.  Use the command STRTCPSVR 
SERVER(*MGTC) on your Central System to ensure it is started.  Remember, you must also start your monitors to see them in 
your list of monitors. 

Q: I keep getting an error about a class not found but the classpath in WebSphere is set.  Why does it still indicate a problem?
A:  Most likely, you did not restart the server after changing the configuration. 

Q: Why do I get "Authentiation error: no user or password specified"?
A: MC-Pervasive requires at least basic authentication to retrieve the user id and password for retrieving monitoring lists, etc.
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Reference, Documentation and Trademarks
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Where to go now

Management Central
www.ibm.com/eserver/iseries/sftsol/mgmtcentral.htm

Management Central - Pervasive: Users Guide & FAQ
www.ibm.com/eserver/iseries/sftsol/pervasive.htm

AS/400 WebSphere
www.ibm.com/eserver/iseries/websphere

AS/400 HTTP
www.ibm.com/eserver/iseries/http

Redbook: 
AS/400 Internet Security Scenarios: A Practical Approach SG24-5954
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Web Pages

AS/400 Systems Management
www.ibm.com/eserver/iseries/sftsol

Systems Management Partner Group
www.ibm.com/eserver/iseries/smpg

Management Central
www.ibm.com/eserver/iseries/sftsol/mgmtcentral.htm

Operations Navigator
www.ibm.com/eserver/iseries/oper_nav

Advanced Job Scheduler
www.ibm.com/eserver/iseries/jscheduler

Tivoli
www.tivoli.com
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Trademarks and Disclaimers

AS/400 IBM Logo
AS/400e iSeries
e-business logo OS/400
IBM WebSphere

Lotus, Freelance, and Word Pro are trademarks of Lotus Development Corporation in the United States,  other countries, or both.
Tivoli and NetView are trademarks of Tivoli Systems Inc. in the United States,  other countries, or both.
C-bus is a trademark of Corollary, Inc. in the United States, other countries, or both. 
Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States, other countries, or both. 
Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both. 
PC Direct is a trademark of Ziff Communications Company in the United States, other countries, or both and is used by IBM Corporation under license. 
ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel Corporation in the United States, other countries, or both. 
UNIX is a registered trademark of The Open Group in the United States and other countries.
SET and the SET Logo are trademarks owned by SET Secure Electronic Transaction LLC. 
Other company, product and service names may be  trademarks or service marks of others.

Information is provided "AS IS" without warranty of any kind.

All customer examples described are presented as illustrations of how those customers have used IBM products and the results they may have achieved.  Actual environmental costs and 
performance characteristics may vary by customer.

Information in this presentation concerning non-IBM products was obtained from a supplier of these products, published announcement material, or other publicly available sources and 
does not constitute an endorsement of such products by IBM.  Sources for non-IBM list prices and performance numbers are taken from publicly available information, including vendor 
announcements and vendor worldwide homepages.  IBM has not tested these products and cannot confirm the accuracy of performance, capability, or any other claims related to non-IBM 
products.  Questions on the capability of non-IBM products should be addressed to the supplier of those products.

All statements regarding IBM future direction and intent are subject to change or withdrawal without notice, and represent goals and objectives only.  Contact your local IBM office or IBM 
authorized reseller for the full text of the specific Statement of Direction.

Some information in this presentation addresses anticipated future capabilities.  Such information is not intended as a definitive statement of a commitment to specific levels of 
performance, function or delivery schedules with respect to any future products.  Such commitments are only made in IBM product announcements.  The information is presented here to 
communicate IBM's current investment and development activities as a good faith effort to help with our customers' future planning. 

Performance is based on measurements and projections using standard IBM benchmarks in a controlled environment.  The actual throughput or performance that any user will experience 
will vary depending upon considerations such as the amount of multiprogramming in the user's job stream, the I/O configuration, the storage configuration, and the workload processed.  
Therefore, no assurance can be given that an individual user will achieve throughput or performance improvements equivalent to the ratios stated here.

Photographs shown are of engineering prototypes.  Changes may be incorporated in production models.
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Appendix
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